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Worum geht es?
In vielen Ländern der Erde werden Flüsse aufgestaut und erfolgreich zur Energieerzeugung genutzt – Brasilien, Norwegen und der bekannte Drei-Schluchten-Staudamm in China sind prominente Beispiele dieser weit verbreiteten Technik. Dabei wird mittels Turbinen der Fall des Wassers auf ein tieferes Niveau zur Stromerzeugung genutzt.
Auch unsere Schweizer Flüsse sind praktisch alle zur Energienutzung mehrmals aufgestaut. Für die Kraftwerksbetreiber ist es wichtig, die Menge des Wassers möglichst genau zu kennen. Oft möchte man auch die Wassermenge vergrössern, um noch mehr Energie zu erzeugen. Das kann mit einer Erhöhung der Staumauer erreicht werden.


Die Daten
Um diese Analyse mit GIS vorzunehmen, braucht es räumliche Informationen über die betreffende Region. Man muss die Topographie und das Gewässernetz kennen. Diese Informationen müssen in digitaler Form - das heisst in Zahlen - vorliegen.
Über die Landnutzung führen in der Regel die Gemeinden und der Kanton Buch. Sie verwalten die aktuellen Zonenpläne (Bauzone, Landwirtschaftszone, Wohnzone usw.). Dabei handelt es sich um gezeichnete Karten und Pläne, welche heute oft in digitaler Form erhältlich sind. Im Aargau sind die meisten dieser Karten digitalisiert und werden vom AGIS (Aargauische Geographische Informationsstelle) verwaltet.
Die folgenden Datensätze stehen zur Verfügung::
· Digitales Höhenmodell: d10g_20000215 (Raster, Auflösung 10 x 10 m)
· Gewässernetz Kanton Aargau (Linien): xgwn_449_20040525.shp
· Orthophoto der Region (Raster): off3r_1529_2001_2.tif


Die Fragestellung
Exemplarisch werden wir an der Region Baden-Wettingen folgende Fragen beantworten:
· Aus welchem Gebiet fliesst Wasser zur Staumauer von Wettingen?
· Wie gross ist die Fläche dieses Einzugsgebietes?
· Wieviel Niederschlagswasser fliesst jährlich in den Stausee?
· Wie würde das Gelände aussehen, wenn die Staumauer auf 390 m.ü.M. erhöht würde?
· Welche und wie viele Gebäude müssten dem neuen Stausee weichen?
· Welche Wassermenge würde nun zusätzlich zur Verfügung stehen?
	

Grundsätzliches
In dieser Übung werden folgende GIS-Techniken angewendet:
· Eingrenzung von Raster und Vektordaten auf eine Region
· Umwandeln von Vektor- in Rasterdaten
· Eine neue Vektordatei erstellen und editieren (Ausflusspunkt)
· Rasterdaten neu berechnen (Überflutung simulieren)
· Bearbeitungsraum eingrenzen (Maske für die Berechnung)
· Statistische Informationen über die Zellen einholen (Fläche des Einzugsgebietes)
· Volumen des neuen Stausees bestimmen

Die Lösungschritte mit ArcGiS


Übersicht: 3D Ansicht der Region Baden-Wettingen (Arcscene)
Zuerst wollen wir uns eine Übersicht über das Gebiet verschaffen. ArcGis bietet mit dem Modul ArcScene die Möglichkeit dreidimensionale Karten einer Oberfläche zu erstellen. Dazu brauchen wir ein digitales Höhenmodell, welches die Höhenangaben des Gebietes liefert. Wir überlagern diese Reliefdaten mit der Landnutzung (drape image) und erhalten eine 3D-Darstellung der Oberfläche, auf der die Landnutzung sichtbar wird. Die neue Karte zeigt uns die räumliche Verteilung der Waldgebiete, Seen, Dörfer usw..


1. Ausschnitte für unsere Region
Die Karten vom AGIS umfassen in der Regel den gesamten Kanton Aargau. Wir werden zuerst alle Datensätze auf einen Ausschnitt für unsere Region reduzieren.

a) Digitale Höhenkarte für Wettingen ausschneiden
Wir benötigen dazu das digitale Höhenmodell des Kantons Aargau in einer Auflösung von 10 Meter. (d10g_20000215 (im Ordner 468_DHM10_Geländemodell-Ra).
1. Add Layer > d10g_20000215 (im Ordner 468_DHM10_Geländemodell-Ra).
1. Anzeige so einstellen (Lupe, Hand), dass nur der gewünschte Ausschnitt angezeigt wird.
2. Fenster > Bildanalyse >  d10g_20000215 aktivieren (leuchtet blau).
3. Bildanalyse > Verarbeitung > Ausschneiden
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Der berechnete Ausschnitt erscheint nun in der Anzeige als neue Rasterdatei mit dem Namen “Clip_d10g_20000215“. Achtung: Diese Datei ist nur temporär gespeichert, sie wird gelöscht, sobald ArcGIS ausgeschaltet wird. Die Datei muss gesichert werden. Dazu mit der rechten Maustaste auf den Namen klicken und Daten > Daten exportieren. Speichern Sie die Datei unter einem sinnvollen Namen an einem sinnvollen Ort.
b) Gewässernetz auswählen (Features auswählen)[image: ]
Bei Vektordaten kann man mit dem „Features Auswählen“ Werkzeug die gewünschten Punkte, Linien oder Polygone auswählen und anschliessend aus diesen ausgewählten Objekten eine neue Karte erstellen.Auf das „Features auswählen“ Werkzeug klicken, mit dem Pfeil ein Rechteck aufziehen, welches alle Gewässer enthält, die etwa den Ausmassen der Topographiekarte entsprechen. Die ausgewählten Flüsse erscheinen in hellblauer Farbe. Ist die Auswahl zu gross oder zu klein ausgefallen, so kann man entsprechend korrigieren: 
Auswahl > Interaktive Auswahlmethode > „Aus aktueller Auswahl entfernen/hinzufügen/auswählen“.


c) Neue Layer Gewässernetz Baden-Wettingen erzeugen
Rechte Maustaste auf die Layer des Gewässernetzes > Daten exportieren > Ausgewählte Features > Speicherort und Namen angeben. Die ursprüngliche Layer des gesamten Gewässernetzes kann nun entfernt werden.


2. Ausflusspunkt (Pour Point) bestimmen
Wir  überlegen uns zuerst, wo das Wasser aus dem Einzugsgebiet einmünden soll, d.h. wir müssen einen Ausflusspunkt (Pour Point) bestimmen. Wir interessieren uns ja für den Stausee von Wettingen, der Ausflusspunkt muss demnach die Staumauer des Wettinger Kraftwerks sein. Dazu werden wir eine neue Vektordatei (Punkt) erzeugen, welche den Ort des Pour Points markiert.

a) Neue Datei erstellen (Shapefile Punkt)
Das Programm-Modul ArcCatalog[image: ] aufstarten und einen Ordner auswählen, in welchen die Neue Datei hineinkommen soll.
Neu > shape datei > Bearbeiten > Koordinatensystem übernehmen von einer anderen Point Datei (z.B. Mobilfunkantennen) oder ein vordefiniertes Koordinatensystem auswählen (Projected, National Grids CH1903_LV03 (s. Abbildung).
[image: ][image: ]

b) Neue Vektordatei editieren
Wechseln Sie wieder zu ArcMap und fügen Sie das Orthophoto und die neu erstellte shape Datei hinzu. Das Orthophoto lässt die Lage des Staudamms gut erkennen.
Aktivieren Sie nun die noch leere shape Datei und starten Sie die Bearbeitung: Ansicht > Werkzeugleisten > Editor: Bearbeitung starten > Neues Feature erstellen > Bleistift Symbol > Bearbeitung beenden. Die shape Datei enthält nun den „Pour Point“ also den Ausflusspunkt. Zusammen mit der Topographischen Karte können wir nun eine Karte des Wassereinzugsgebietes berechnen.
[image: ][image: ]

3. Karte der Abflussrichtung (flow direction)
Das Wassereinzugsgebiet wird über zwei Schritte berechnet. Zuerst muss eine Karte der Abflussrichtung (flow direction) erstellt werden.
Arc Toolbox > Spatial Analyst > Hydrology > Flow Direction > dhm10wett als Oberflächenraster angeben > sinnvoller Name des Abflussrichtungsrasters eingeben.
[image: ]


4. Karte für das Wassereinzugsgebiet (watershed)
Nun können wir mit dem Werkzeug „watershed“ und dem Abflusspunkt eine Karte des Einzugsgebietes berechnen:
Arc Toolbox > Spatial Analyst > Hydrology > watershed
Flowdirection Raster > Pour Point File: erstelltes shapefile (Punkt am Staudamm von Wettingen). Sinnvoller Name und Speicherort für das Output File bestimmen.
[image: ]
Lassen Sie sich diese Layer transparent anzeigen damit die Topographie darunter sichtbar bleibt: Rechtsklick auf die Layer > Eigenschaften > Anzeige > Transparent 50%.
Erzeugen Sie eine Schummerung der topographischen Karte: Spatial Analyst > Oberfläche > Schummerung. Legen Sie das transparente Einzugsgebiet über das Schummerungsbild des digitalen Höhenmodells und zuoberst das Gewässernetz. [image: ]


5. Fläche bestimmen
Wie gross ist die Fläche des Einzugsgebietes?
a) Rechtsklick auf die Layer des Einzugsgebietes > Attributtabelle anschauen. Spalte Count zeigt die Anzahl der einzelnen Pixel (Auflösung 10 x 10 m). Hier kann also die gesamte Fläche des Einzugsgebietes abgelesen werden. Wie gross ist sie in km2? (ca. 100 km2)
b) Wieviel Niederschlagswasser fliesst pro Jahr in den Stausee, wenn die Durchschnittliche Niederschlagsmenge ca. 1200 mm/J beträgt? Um wie viel steigt der Wasserspiegel des Stausees, bei einem starken Gewitter mit 200 mm Niederschlag pro Ereignis?

6. Höhenverteilung des Einzugsgebietes (Zonenstatistik)
Das Wassereinzugsgebiet ist auf unterschiedliche Höhenniveaus verteilt. Die Erfahrung zeigt, dass in praktisch allen Regionen der Erde die Niederschlagsmenge mit der Höhe zunimmt - je höher desto mehr Niederschlag. Wenn nun ein grosser Teil des Einzugsgebietes auf obere Höhenstufen verteilt ist, so muss mit mehr Niederschlag gerechnet werden, als wenn die das Einzugsgebiet auf untere Niveaus beschränkt ist.
Zonenstatistik ermöglicht eine Übersicht über die Höhenverteilung der Gebiete.
a) Höhenzonen
Das digitale Höhenmodell muss zuerst umgewandelt werden in ein Format mit ganzen Zahlen (Integer): Spatial Analyst > Raster berechnen > Erweitert > int > dhm10 > berechnen.
[image: ]

b) Zonenstatistik
Wir werden nun für jeden Höhenmeter die Anzahl der Pixel (= Fläche) ermitteln und somit sehen wie diese auf die Höhenstufen verteilt sind. Spatial Analyst > Zonenstatistik > Als Zonendatei die neue Berechnung angeben (Höhenzonen), als Wertraster die Rasterdatei mit der Fläche des Wassereinzugsgebietes.
[image: ]
Die erzeugte Tabelle enthält die für uns wichtigen Informationen in den Spalten Value und Count oder Area. In der Spalte Value sind die Höhenwerte über Meer angegeben (einzelne Meter Schritte). Die Spalte Count enthält die Anzahl der Pixel und Area die Fläche dieser Pixel in m2.
c) Flächenverteilung in Grafikform
Wir werden nun eine Grafik zeichnen, mit der Fläche (Count oder Area) auf der Y-Achse und den Höhenwerten auf der X-Achse und so eine Übersicht über die Höhenverteilung der Gebiete erhalten.
Rechtklick auf die Titelleiste des Diagramms > Eigenschaften; Typ Linie wählen. Daten so ausfüllen wie in der Abbildung (Höhenstufen m.ü.M. auf X-Achse, Fläche der jeweiligen Höhenstufe auf Y-Achse).
Das Menu Aussehen erlaubt weitere Einstellungen des Diagramms (Titel usw.).
[image: ][image: ]


7. Neuer Stausee in Wettingen
a) Bearbeitungsgebiet eingrenzen (Maske setzen)
Wenn wir eine höhere Staumauer planen, so wird der neue, grössere Stausee alles was unter der neuen Staumauerhöhe liegt überfluten. Allerdings nur die direkt in der Umgebung des Sees tiefer liegenden Gebiete. Dieser Situation müssen wir Rechnung tragen, indem wir die Topographie eben nur in diesem Bereich bearbeiten lassen.
Zu diesem Zweck erstellen wir in drei Schritten eine sogenannte Maske, welche das Gebiet eingrenzt.
1. Schritt: Neue leere Shape Datei (Polygon) erstellen mit ArcCatalog (s. 2. a)
2. Schritt: Diese neue Shape Datei in ArcMap editieren (Editor > Bearbeitung starten > Wir zeichnen ein Polygon worin wir die Begrenzung der Überflutung durch die Staumauer vermuten (Siehe Abbildung unten). Bearbeitung beenden.
[image: ]
3. Schritt: Diese Shape Datei (Maske) ins Rasterformat umwandeln.
Spatial Analyst > Konvertieren > Features zu Raster > sinnvollen Namen angeben
[image: ]

Wir können nun dieses Raster als Maske für alle weitern Bearbeitungen mit dem Spatial Analyst setzen: Spatial Analyst > Options > Allgemein; dort bei „Markierung für die Analyse“ diese Rastermaske auswählen.
[image: ]

b) Überflutung simulieren
Alles was unter 390 m.ü.M wird im eingegrenzten Gebiet überflutet, d.h. es wird nach der Erhöhung des Seespiegels hier keine Höhen unter 390 m.ü.M. mehr geben. Wir müssen die Topographie im eingegrenzten Bereich entsprechend verändern.
Spatial Analyst > Raster berechnen > wenn Formel eingeben siehe unten.
[image: ]
Diese Bedingungsformel in Worten:
1. Test (con): Teste die Werte in der Topographie, ob sie kleiner oder gleich 390 sind.
2. Findest Du einen Wert für den das zutrifft (<=390), so änderst Du ihn auf 390.
3. Findest Du einen Wert für den das nicht zutrifft, so übernehme die Werte der ursprünglichen Topographie (lasse sie unverändert).

Damit erreichen wir, dass alle Gebiete, welche tiefer liegen als 390 m.ü.M. auf 390 m geändert werden (= Überflutungsniveau).

c) Wasserfläche/Wassermenge
Wir haben nun zwei Topographien – eine vor dem neuen Stausee und eine mit dem neuen Stausee. Damit können wir mit dem Funktion Spatial Analyst > Abtrag/Auftrag eine Raserkarte erzeugen, worin wir den neuen Stausee erkennen und aus der Attribut Tabelle die Fläche und die Wassermenge herauslesen.
[image: ][image: ]

Ändern Sie die Anzeige des Sees so, dass der Netto-Gewinn blau, der Netto-Verlust rot und unverändert „Farbe ist null“ erhalten. Die neue Karte (Schummerung im Hintergrund) lässt das Ausmass des Sees gut erkennen.

[image: ]

Die Attributtabelle zeigt in der zweiten Zeile das Volumen und die Fläche des neuen Stausees. Wählen Sie diese zweite Zeile aus (am linken Rand in die Zeile klicken) und in der Karte im Hintergrund erscheint der See hellblau.
[image: ]

d) Überschwemmte Gebäude
Offensichtlich müssten diesem Stauseeprojekt einige Häuser weichen. Das erkennen wir, wenn wir die Karte der Gebäude des Kantons Wettingen hinzufügen. (Leider reicht die Gebäudekarte nicht über die Kantonsgrenze hinaus). Wir möchten natürlich wissen, welche Gebäude das sind und wie viele. Dazu verwandeln wir den Stausee (Raster Datei) zuerst in ein Polygon und können anschliessend alle Gebäude auswählen lassen, welche in diesem „Stauseepolygon“ liegen.
1. Stausee auswählen
In der Attribut-Tabelle die zweite Zeile mit dem Stausee auswählen.

[image: ]

2. Stausee in Polygon umwandeln
Spatial Analyst > Raster zu Feature > Polygon > Speicherort und Name wählen..
[image: ]

3. Gebäude im Stausee auswählen (Llagebezogene Auswahl):
[image: ][image: ]

Die überfluteten Gebäude werden hellblau angezeigt. Erstellen Sie aus den Ausgewählten Gebäuden eine neue Datei: Rechtsklick auf die Gebäude Layer > Daten exportieren > Speicherort und Name angeben und die Auswahl der Gebäude wieder aufheben.
Lassen Sie sich die neue Datei als Layer anzeigen und schauen Sie in der Attributtabelle nach wie viele Gebäude es sind (jedes Polygon = 1 Gebäude).

Schluss: Anzeige mit Orthofoto
Lassen Sie sich das Stauseepolygon in blau und die Wettinger Gebäude in grün und die Überfluteten Gebäude in rot über dem Orthofoto anzeigen.

[image: ]
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